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Introduction
About Firefox
Mozilla Firefox (originally known as "Phoenix" and briefly as "Mozilla Firebird") is a 
free, cross-platform, graphical web browser developed by the Mozilla Foundation and 
hundreds of volunteers. Its current release is Firefox 1.5, released on November 29, 2005.

Firefox strives to be a lightweight, fast, intuitive, and highly extensible standalone 
browser. Firefox has now become the foundation's main development focus. Firefox 
includes an integrated pop-up blocker, tabbed browsing, live bookmarks, support for 
open standards, an extension mechanism for adding functionality and localization for 
Firefox in different languages. Firefox also attempts to produce secure software and fix 
security holes promptly. Although other browsers have introduced these features, Firefox 
is the first such browser to achieve wide adoption.

Firefox has attracted attention as an alternative to other browsers such as Microsoft 
Internet Explorer. As of October 2005, estimates suggest that Firefox's usage share is 
around 9% of overall browser usage. Since its release, Firefox has slightly reduced 
Internet Explorer's dominant usage share.

History of Firefox
Before its 1.0 release on November 9, 2004, Firefox had already gained acclaim from 
numerous media outlets, including Forbes and the Wall Street Journal. With over 25 
million downloads in the 99 days after its release, Firefox became one of the most 
downloaded free and open source applications, especially among home users. On October 
19, 2005, Firefox had its 100 millionth download, just 344 days after the release of 
version 1.0.

Firefox has become the foundation's main development focus (along with its Thunderbird 
email client), and has replaced the Mozilla Suite as their official main software release.

Blake Ross began working on the Firefox project as an experimental branch of the 
Mozilla project. They believed that the commercial requirements of Netscape's 
sponsorship and developer-driven feature creep compromised the utility of the Mozilla 
browser. To combat what they saw as the Mozilla Suite's software bloat, they created a 
pared-down browser (then known as Phoenix, today known as Firefox), with which they 
intended to replace the Mozilla Suite. Ben Goodger currently works as the lead developer 
of Firefox.

Mozilla Firefox retains the cross-platform nature of the original Mozilla browser by using 
the XUL user interface markup language. Through Firefox's support of XUL, users may 
extend their browser's capabilities by applying themes and extensions. Initially, these 
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add-ons raised security concerns, so with the release of Firefox 0.9, the Mozilla 
Foundation opened Mozilla Update, a website containing themes and extensions 
"approved" as not harmful.

Standards

Support for software standards

The Mozilla Foundation takes pride in Firefox's compliance with existing standards, 
especially W3C web standards. Firefox has extensive support for most basic standards 
including HTML, XML, XHTML, CSS, ECMAScript (JavaScript), DOM, MathML, 
DTD, XSL and XPath.

Firefox also supports PNG images and variable transparency as opposed to Internet 
Explorer, which will not support it fully until the not-yet-released version 7. Indeed, 
Internet Explorer's lack of support for PNG images has occasioned much debate, as many 
web developers want to move away from the old GIF format, which does not have the 
same capabilities and image quality as PNG.

Mozilla contributors constantly improve Firefox's support for existing standards. Firefox 
has already implemented most of CSS Level 2 and some of the not-yet-completed CSS 
Level 3 standard. Also, work continues on implementing standards currently missing, 
including SVG, APNG, and XForms. The latest development builds include SVG support 
by default [17], and the upcoming version 1.5 is thus scheduled to have a partial SVG 1.1 
support. Some of the Mozilla standards like XBL is also making its way to open 
standards (via WHATWG).

Installation

Getting Firefox
Firefox can be downloaded from this page. The "Free Download" link at the top of the 
page will automatically find the correct version for your OS. To get a version of Firefox 
in another language, see this page.
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Installing

Firefox Windows Installer

Microsoft Windows

Firefox supports various versions of Windows including 98, 98SE, Me, NT 4.0, 2000, 
XP, and Server 2003, although it is possible to run Firefox in Windows 95 [1]. Builds for 
Windows XP Professional x64 Edition also exist [2]. The Microsoft Windows version of 
Firefox is distributed as an executable installer. To install, double click on Firefox Setup 
<version>.exe (where <version> is a number) and follow the installation instructions. 
Choosing the standard installation is recommended for most new users. This will install 
Firefox under Program Files.

You can run Firefox from the Program Files entry or by double-clicking the Firefox icon 
on your desktop. The first run of Firefox will give you the option of importing your 
settings from Internet Explorer (or any other browser installed on you computer). 
Choosing 'Yes' will import all your bookmarks (also known as favorites), saved 
passwords, history and browsing options. After it finishes importing all these settings, the 
Firefox browser will start up and a dialog box will pop-up alerting you that Firefox is not 
set as the default browser. Selecting 'Yes' will associate Firefox with web related files on 
your PC and Firefox will also open when links are selected from (most) external 
applications, such as from an instant messenger.

After setting Firefox as the default browser, it should automatically appear on the 
Windows XP new-style Start menu under the "Internet" option. However, if it doesn't, it 
can be manually set. Right click on the Start button and select "Properties". From there, 
select "Customize...", and select "Mozilla Firefox" next to the "Internet" checkbox.
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Firefox MacOSX Disc Image

Mac OS X

Double click on the compressed Disk Image to mount it. Drag the Firefox application 
icon to the "Applications" folder on your hard drive. Do not double-click the Firefox icon 
inside the Disk Image; doing so can cause a program hang. To make Firefox always 
appear in the dock, drag the icon from the "Applications" folder to the dock.

Linux

Many distributions now come with Firefox included. Check your distribution's 
documentation for details. There should be a Firefox icon in your desktop environment's 
program menu.

If your distribution does not come with Firefox pre-installed, you may download it from 
the official Firefox website. Once the download is complete, decompress the file, which 
can be done usually by opening the file in a file archiver (such as ark or file roller) and 
extract it to another folder. Alternatively, typing tar -xvzf firefox-
<version>.tar.gz or tar -xvzf firefox* at a command line will generate directory 
named "firefox." This directory can be moved anywhere. Typing ./firefox in the shell 
from the install directory should run Firefox.

Other Operating Systems

Since the Mozilla Foundation makes the Firefox source code available, users can also 
compile and run Firefox on a variety of other architectures and operating systems. 
Operating systems not supported by Firefox, but known to run the browser include:

• Solaris (x86 and SPARC)
• OS/2
• AIX
• FreeBSD
• PC-BSD
• NetBSD
• BeOS
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• SkyOS
• RISC OS (ARM)
• OpenBSD

Browsing with Tabs
What are tabs?
Firefox has been designed to be useable by any user immediately--with no learning curve. 
However to truly "rediscover the web", you should become comfortable with Firefox's 
advanced features. One of these is the use of tabs. Firefox uses "tabs" to show multiple 
web pages in the same window. This is the most notable difference between Firefox and 
Internet Explorer (its main competitor) for new users.

The default look of Firefox, with tabs visible

Tabs are featured underneath the Location and Bookmarks Toolbars, in a file folder-like 
layout. Tabs allow users to have one Firefox window in the taskbar, with multiple web 
pages open within that window. In the image, the default Firefox homepage is shown in 
the first tab, and Firefox Central (accessed from the "Getting Started" bookmark) is 
shown in the second. The number of tabs that can be opened at any one time is unlimited, 
though the tab bar can only hold around 20 tabs comfortably. Also, Firefox does not 
display the tab bar unless more than one tab is open (there is an option to change this).

Create, close, and select tabs
There are many different ways to both create, close, and access tabs. First, a new blank 
tab can be created by clicking on File → New Tab, or by using the keyboard shortcut 
[Ctrl]+[T]. If the tab bar is visible, an empty space (i.e., one not occupied by a tab) can be 
right clicked, and "New Tab" will create a new tab. Similarly, double clicking an empty 
space on the tab bar will create a new blank tab. Another way to create a tab, arguably the 
most common, is by clicking the middle mouse button (sometimes referred to as the third 
mouse button, or scroll wheel) on any link or bookmark (for instance, "Getting Started" 
in the above image). Finally, holding down the [Ctrl] key and left clicking a link will 
open that website in a new tab.

There are also a variety of different ways to close tabs. First, File → Close or [Ctrl]+[W] 
will close the currently selected tab. Also, the red "x" on the right edge of the tab bar will 
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close the current tab. Finally, middle clicking on any tab (it doesn't have to be selected), 
or right clicking and selecting "Close Tab" will close whichever tab was selected.

Finally, there are a few different ways to select tabs. The most obvious is to simply left 
click on a tab. However, a keyboard shortcut also exists: [Ctrl]+[Number] where 
"Number" is any number 1-9. The corresponding tab will then be selected. Of course, this 
only works for the first 9 tabs opened. Another common keyboard shortcut is 
[Ctrl]+[Tab]. This will make the next tab active. Using [Ctrl][Shift]+[Tab] will select the 
previous tab. These shortcuts are an easy way to cycle through the currently open web 
pages.

A new feature in Firefox 1.5 is the ability to "Drag and Drop" tabs. By clicking and 
holding down the left mouse button on a tab, it is possible to change the order of tabs. 
Once the desired location is found (as signaled by an arrow), the left button can be 
released, and the tab will be moved.

In addition to basic functionality, there are many other ways to use tabs.

Customization
For Tab preferences, see the chapter on Preferences.

Multiple home pages
Tabbed browsing also enables another feature: multiple home pages. With multiple home 
pages, it is possible to have several pages open each time the browser is opened or the 
"Home" button is selected.

To set multiple home pages, go to the "Preferences" window, accessible from Tools → 
Options on Windows, Edit → Preferences on Linux, or Firefox → Preferences on OS X. 
Once in the Preferences window, select the General panel, and type each URL, separated 
by a pipe character (which is |), in the Home Page box. For example:

http://addons.mozilla.org/|http://www.google.com|
http://wikibooks.org/wiki/Special:Randompage

An easier way to set multiple homepages is to open all of the desired sites in tabs 
(making sure only the desired sites are opened) and then click the Use Current Pages 
button from the General tab of the Preferences window.

Bookmark Groups
Bookmarks Groups are very similar to Multiple Home pages. Bookmark Groups create a 
folder with multiple related (or unrelated, even) bookmarks. It is then possible to open all 
of them at once by clicking on the created folder and clicking Open in Tabs. Alternately, 
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you can simply open just one of the bookmarked web sites. To create a Bookmark Group, 
simply open each desired site in its own tab (again, be sure to only open the sites you'd 
like in the group). From there, a few ways exist to create a group:

• Right click on a tab and select Bookmark All Tabs...
• Click on Bookmarks → Bookmark All Tabs...
• Hit [Ctrl]+[Shift]+[D]

No matter which way you create the group, the same window will appear, asking you for 
a name and where to create the group.

Middle click to close tabs on Linux
When using Firefox on Linux, the default behavior when middle clicking is to try to load 
whatever is currently in the clipboard as if it were a URL. If you prefer to use the middle 
click to close tabs, type about:config in the location bar and hit enter.

In the new window that appears, type middlemouse.contentLoadURL in the box labeled 
Filter:. Then, right click on the preference, and select Toggle, which should set the 
preference to false.

(Another contributor writes: Unfortunately, in some versions--- such as the one I'm using 
now---this simply causes Firefox to do nothing when you middle-click a tab. 'Twould be 
nice to figure out how to really fix this!)

Searching and finding within documents
Quick searches and keywords
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Select "Add a Keyword for this Search".

A Name and the Keyword w were just entered for this Quick Search.

Quick Searches allow you to define custom search keywords for entering in the Location 
Bar. After setup, just type your search keyword before your search terms. A wiki of 
popular quick searches is maintained here. The steps needed to make a new Quick Search 
are outlined below:

1. Go to a web page that contains a search box.
2. Right click in the search entry box.
3. Select "Add a Keyword for this Search".
4. Give your quick search a keyword. For example, a Wikipedia search could be w. 

Obviously, shorter keywords are more efficient than longer ones, such as 
wikipedia.

An alternative method for older versions of Firefox or locations without search boxes is 
to:

1. Go to a webpage that contains a search box.
2. Search for something. In this case, oddball will be the search word.
3. Note the term in the URL, and replace it with %s. For example, searching on the 

Google search engine gives us the URL:

http://www.google.com/search?hl=en&q=oddball&btnG=Google+Search
Using our example, the new address would be: 
http://www.google.com/search?hl=en&q=%s&btnG=Google+Search

1. Copy the modified URL from the location bar.
2. Go to Bookmarks → Manage Bookmarks → New Bookmark.
3. Paste your modified URL in the Location box.
4. Give your quick search a name, e.g. Google Quick Search.
5. Give your quick search a keyword. Note: This can be one character or more. For 

example, a Google search could be g.

To use your new quick search all you need to do is type keyword your search term in 
the address bar; for example, to search for the information regarding the history of 
Wikipedia in Google, you would type, g history of wikipedia. You can also 
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bookmark advanced searches using the same technique. Just try a search and replace your 
search term with %s. Simple!

This functionality doesn't have to be limited to web searches; it can be used to quickly go 
to pages that have a certain structure. For example, one way to get more out of Wikipedia 
would be to create a bookmark to http://en.wikipedia.org/wiki/%s with keyword 
w. Getting to Wikipedia articles now only requires typing in w article title.

Another example is currency conversions. To easily convert from US dollars to Euro, one 
could create a bookmark to 
http://www.xe.com/ucc/convert.cgi?From=USD&To=EUR&Amount=%s and give it the 
keyword $. To convert a given amount (say $50), all one has to do now is enter $ 50 into 
the address bar (note the space, it's very important).

Once you start thinking about them, keywords can become quite useful.

You can also use the SmartSearch extension to do all your quick searches from the 
context menu, by highlighting a word on 
a page, right-clicking it and search using 
any of your quick searches.

Find Toolbar

Screenshot of performing "Find as you 
type". "ency" was being typed and the 
first matched text was highlighted in 
green.

A new and innovative feature is the Find Toolbar. The Find Toolbar is used for searching 
for text within a page without being too obtrusive. When activated by pressing Ctrl+F, 
the Find Toolbar appears on the bottom of the Firefox browser ready to search the current 
web page. The Find Toolbar using incremental searching which means that it will look up 
your search term simultaneously as you type it. This is more robust than traditional find 
as finding is done immediately when typing starts. The Find Toolbar has the ability to 
find the next or previous result and select it, highlight all the matched results and match 
case. Firefox will search down until reaching the end of the document and "wraparound" 
to the beginning of the page. If there are no results matching your terms, Firefox will 
'beep' quietly to inform you of this. When you are done searching, simply press the Esc 
key and the Find Toolbar will hide.

Find As You Type

A very useful feature is Find As You Type, which lets you use the functionality of the 
Find Toolbar without having to open or close it with Ctrl+F or Cmd+F.
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By default, Find As You Type will only begin after pressing the / key. Alternatively, to 
only search links, press the ' key (apostrophe). However, it is possible to have Find As 
You Type work without needing an additional key press. To do so, go to Tools → 
Options → Advanced → General and check "Begin finding when you begin typing".

From now on, when searching about some topic on a website, just start typing into the 
body of the page. You will instantly go to the first instance of the sequence of letters as 
you type. The Find Toolbar will temporarily appear at the bottom of the page, allowing 
you to highlight all the places the term occurs, or jump to the next one. More Find 
Toolbar shortcuts can be found in the Keyboard shortcuts section, and a complete 
description here.

A useful tip to navigate around a web page is to use find as you type. You simply push 
the ' key (apostraphe) and begin typing the text of the link you wish to follow. Once 
Firefox highlights that link (whether you've only typed a few letters or the entire word), 
you hit the Enter key and Firefox will begin loading that page. For example, if on this 
same page, you quickly want to go to the Table of Contents. Notice that the link for the 
table of contents is << To Contents. Press the apostraphe key to activate the Find Toolbar 
for searching for links and then type "to". Firefox will then highlight part of the link. 
Pressing enter will take you to the Using Firefox Table of Contents. One thing to note is 
that the apostraphe key does not necessarily have to be used for this tip to work; just 
using Find As You Type can accomplish the same thing, but since it searches all text, 
whether it's a link or not, it may not be as quick as beginning your search with the 
appostraphe key.

User preferences
Preferences
To access the Preferences window, navigate to Tools → Options on Windows, Edit → 
Preferences on Linux, or Firefox → Preferences on OS X.

General

The General tab

The General Tab of the Preferences window allows you 
to change a few things:

• Home Page
• Default Browser
• How Firefox connects to the Internet
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http://en.wikibooks.org/wiki/Using_Firefox:_Keyboard_shortcuts


The Home Page setting will most likely be the most used from this window, as the other 
two only need to be set once (if at all). There are four ways to set a home page from this 
window:

• Type an address into the Location(s): box (i.e., http://www.google.com)
• Select the Use Current Page(s) button, which will set the current page as the 

home page if only one is showing, or set all tabs as multiple home pages
• Select the Use Bookmark... button to open a dialog that will allow you to select a 

site currently bookmarked as the home page
• Select Use Blank Page to have about:blank set as the home page.

The first time Firefox is launched, it will check if it is set as the default browser. The 
option Firefox should check to see if it is the default browser when starting, when 
checked, will make sure that Firefox remains the default browser (or, if Firefox is not the 
default browser, it will ask you each time if you'd like it to be). Also, pressing Check now 
will do the check after the browser has already been started.

The Connection Settings button only needs to be used if you use a proxy to connect to the 
Internet. If so, you can have Firefox auto-detect the settings, manually enter them, or use 
an automatic proxy configuration URL.

Privacy

The Privacy tab is described as follows: As you browse the web, Firefox keeps 
information about where you have been, what you have done etc. in the following areas: 
Each area has its own settings. As you select tabs inside the Privacy Tab, the main 
content area will change. However, there is one setting at the bottom of the window that 
is accessible from each tab. It says The Clear Private Data tool can be used to erase your 
private data using a keyboard shortcut or when Firefox closes. along with a Settings... 
button. Selecting that button will bring up a list of information that Firefox stores. Each 
can be set or unset individually. In addition to selecting which data you'd like cleared, 
there is an option to Clear private data when closing Firefox and another to Ask me 
before clearing private data. All private data that you have selected can be cleared at any 
time during a browsing session by hitting [Ctrl]+[Shift]+[Del].

History

The Privacy Tab with History selected

The History tab has only two items:

• Remember visited pages for the last __ day(s).
• A button to Clear Browsing History Now
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These options are pretty self explanatory. Set the number of days you'd like Firefox to 
remember pages you have visited. Setting the value to 0 will cause Firefox to not use 
History. Pressing the Clear Browsing History Now button will erase all of the History.

The History is available from the Go → History menu item, by pressing [Ctrl]+[H], or by 
going to View → Sidebar → History. The Go menu itself also shows History.

History is an option for "Clear Private Data", and is selected by default.

Saved Forms

The Privacy Tab with Saved Forms selected

This tab, like the History tab, has only two items of 
interest:

• Save information I enter in forms and the Search 
Bar.

• Clear Saved Form Data Now

Checking the box (which is the default setting) will have Firefox save any data that is 
entered in a form. This includes things like the Google search box, any contact 
information (Name, Address, Email, etc) and other search boxes. Also, the Search Box 
included on the default Firefox toolbar (accessible by pressing [Ctrl]+[K]) Unchecking 
this box will stop Firefox from saving this information. Pressing the Clear Saved Form 
Data Now button will remove all the data currently stored by Firefox.

Saved Form Data is an option for "Clear Private Data", and is selected by default.

Passwords

The Privacy Tab with Passwords selected

When Remember Passwords is checked (default), 
Firefox will present you with an option to save a 
password on any site where one is entered. After 
entering a password and hitting the submit button, 
Firefox will present a dialog with three options, 
Remember, Never for This Site, and Not Now. Selecting 
Remember will have Firefox store the password for that 

page, and will automatically enter it on each successive visit. Selecting Never for This 
Site will prevent Firefox from remembering the password for that page, and it will not 
ask to save a password on that page again. Selecting Not Now will prevent Firefox from 



saving the password on that visit, but the dialog will be presented again the next time you 
visit that site.

Firefox also has the option to set a Master Password. Without one, Firefox will 
automatically enter any password that is stored--regardless of who is using the browser at 
that time. A Master Password will cause Firefox to prompt the user for a password before 
it will enter any saved passwords. However, it will only prompt once per session, 
meaning as long as the browser remains open. To prevent unauthorized use of passwords, 
be sure to close the browser when you are finished using it (if you entered a Master 
Password). The Master Password can also be unset from this window.

Pressing the View Saved Passwords button will open a new dialog. This window shows 
every site that Firefox has a username/password saved for. At first, the address of the site 
and the username are displayed. Press the Show Passwords button to display the saved 
passwords. Individual entries can be removed by selecting them, and pressing Remove. 
All entries can be removed with the Remove All button.

Also on the View Saved Passwords dialog is a tab that displays Passwords Never Saved. 
This window is very similar to the Passwords Saved window. Removing an entry from 
this list, however, will cause Firefox to ask to save a password the next time you visit that 
site.

Saved Passwords are an option for "Clear Private Data", but are not selected by default.

Download History

The Privacy Tab with Download History selected

Any time you download an item from the Internet, 
Firefox opens the Download Manager to track it. After 
the download is finished, Firefox will keep that item 
visible. Each item can be removed individually, or the 
entire history can be cleared at once. Also, Firefox can 
be set to never save a history (or clear the download 
history on its own, after each download). The Download 

Manager can be accessed by going to Tools → Downloads, or by pressing [Ctrl]+[J]. It 
can also be accessed by pressing the View Download History button on this pane of the 
Preferences window.

The only setting here affects how Firefox clears the Download Manager. Remove files  
from the Download Manager:

• Upon successful download



• When Firefox exits
• Manually (default)

Upon successful download will erase entries from the Download Manager as they finish 
downloading, When Firefox exits will clear the Download Manager history each time 
Firefox is closed, and Manually will leave all entries in the Download Manager until they 
are removed by the user.

Note: Removing files from the Download Manager does not delete the files from your 
computer. It only removes the history of you downloading it from Firefox.

Download History is an option for "Clear Private Data", and is selected by default.

Cookies

The Privacy Tab with Cookies selected

Cookies are "pieces of information stored by sites on 
your computer. They are used to remember login 
information and other data." This window can be a little 
more confusing than the others.

The first option, which is enabled by default, is Allow 
sites to set Cookies. Next to that option is a button 

named Exceptions. Setting exceptions will allow cookies from every site except for sites 
on the list.

Under that are two more options:

• for the originating site only
• unless I have removed cookies set by the site

Checking the first box will only allow cookies that are from the site you are currently on. 
For other sites to give you cookies, you will have to navigate to that site (with the option 
enabled; it is disabled by default). The second option will except all cookies, as long as 
you have not removed a cookie from that site. For instance, if you remove a cookie set by 
google.com, then google.com will no longer be able to send you cookies.

Beneath those options is a dropdown box. Keep Cookies:

• until they expire (default)
• until I close Firefox
• ask me every time

http://en.wikipedia.org/wiki/HTTP_cookie


Each cookie has an expiration date. By selecting the first option, Firefox will keep each 
cookie until it expires, and then discard it. Selecting the second option will keep all 
cookies only until Firefox is closed. The third option will make Firefox ask you each time 
a site tries to set a cookie, or modify an existing one.

Pressing the View Cookies button will bring up a new window, listing all cookies by site. 
From this window, it is possible to remove one, a few, 
or all cookies. Also, it is possible to view the contents of 
each cookie (though they are usually nonsensical).

Finally, the Clear Cookies Now button will clear all 
cookies.

Cookies are an option for "Clear Private Data", but are 
not selected by default.

Cache

The Privacy Tab with Cache selected

Pages you view are stored in the cache for faster viewing later on. As you visit pages, 
Firefox will automatically save copies of them. If you navigate to the same page later, 
Firefox will use the page saved rather than downloading it again. With this setting, you 
can set the size of the cache.

Use up to __ MB of disk space for the cache. The default value is 50.

Press the Clear Cache Now" button to remove all pages from the cache.

Cache is an option for "Clear Private Data", and is selected by default.

Content

The Content Tab

The first setting on this pane is for blocking popups. 
Firefox is set to automatically enable all unwanted 
popups. The setting is Block Popup Windows, and is 
enabled by default. To the right is an Allowed Sites 
button, that lets you set sites to accept popup windows 
from. When a popup is blocked, the yellow "information 
bar" appears at the top of the window. From there, you 

can allow the popup that was blocked, or allow access for the site to open popups. Sites 



can be removed from the Allowed Sites list, which will cause Firefox to block popups 
from that site again.

Next is the Warn me when web sites try to install extensions or themes. This is also 
enabled by default. To the right of that is an Exceptions button. Any site that is not on the 
Exceptions list (which contains only addons.mozilla.org and update.mozilla.org by 
default) will be blocked from installing extensions or themes. A yellow information bar 
will appear at the top of the window, very similar to the one that appears when a popup is 
blocked. If you want to install an extension or theme from the current site, you can add it 
to the exceptions list, and then retry the install. If the install was unwanted (i.e., a web 
site tried to install a malicious extension), you don't need to take any further action, as the 
install was already blocked. Do not add the site to your exceptions list unless you want to 
install an extension/theme.

Load images is the next preference. It is enabled by default. This preference also has an 
Exceptions list, though it works slightly different from the extensions/themes exceptions 
list. From this list, you can both allow and deny permission for sites to load images. For 
instance, if the Load images preference is enabled, you can use the Exceptions list to 
deny specific sites the ability to load images. If, for example, you did not want 
wikibooks.org to load images, you would type "wikibooks.org" in the Address of the web 
site box, and hit Deny. All other sites would be allowed to load images as normal.

If the Load images preference was disabled, then no images would be downloaded. 
However, if (again for example) you wanted wikibooks.org to be allowed to load images, 
then you would type "wikibooks.org" in the Address of the web site box, this time hitting 
Allow. All images would be blocked except images from wikibooks.org. Both types 
(allowed sites and denied sites) can be set at the same time, but would depend on the state 
of the Load images preference.

Below Load images is a preference (disabled by default) for the originating web site only. 
When enabled, images will only load if they come from the same site as the current page. 
However, this will not display images for such large sites as Yahoo! and Wikipedia, as 
images on those sites are stored on separate servers.

The preference Enable Java (enabled by default), controls whether or not Java applets are 
loaded in Firefox.

Enable JavaScript (enabled by default) controls whether or not JavaScript is executed by 
the browser. Pressing the Advanced... button will bring up a new window with the 
following options: Allow scripts to:

• Move or resize existing windows
• Raise or lower windows
• Disable or replace context menus
• Hide the status bar
• Change status bar text

http://en.wikipedia.org/wiki/JavaScript


The first three are enabled (meaning JavaScripts on a page will be able to do those 
actions) while the last two are disabled by default.

Finally, the Content tab contains Fonts & Colors settings. From this dialog, you can set 
the default font, and the default font size. The Advanced... dialog will allow you to select 
which specific fonts display which font type, and their sizes. The Colors... button allows 
you to set Link, Background, and Text colors.

Tabs

The Tabs tab

The first Tab-related preference is "Open links from 
other applications in:"

• A new window
• A new tab in the most recent window
• The most recent tab/window

These options are mostly self explanatory. When another application (AOL Instant 
Messenger, for instance) tries to open a link, this preference will tell Firefox where to do 
it. The first two are easy enough to figure out, while the third will simply reuse the 
window that was most recently focused (replacing its contents).

The next preference is "Force links that open new windows to open in:"

• The same tab/window as the link
• A new tab

This preference is sometimes referred to as "Single Window Mode", as it prevents the 
"target:_blank" and "target:_new" attributes on links from opening new windows, always 
forcing Firefox to use one window. However, it has been disabled by default, as a few 
crashes have been reported with it enabled. There is little danger in enabling it, as it can 
be easily disabled again if a problem arises.

Three other preferences are on this window:

• Hide the tab bar when only one web site is open
• Select new tabs opened from links
• Warn when closing multiple tabs

The tab bar is hidden by default when only one website is opened. To have it always 
visible, uncheck the box next to the preference. "Select new tabs opened from links" can 
be described as "open a tab in the foreground". In other words, with this preference 
enabled (it's disabled by default), a new tab opened by middle clicking a link will 



automatically be selected and visible. The default behavior is to have the new tab open in 
the background, where you have to manually select it to view it. The final preference is 
visible by opening more than one tab and trying to close the window. A warning will be 
displayed to make sure all of the tabs can be closed.

It is also possible to extend tabbed browsing functionality through Firefox's extension 
system. See Chapter 6 for more details on extensions.

Downloads

The Downloads tab

The Downloads tab has several preferences. First, there 
is the option of setting a "Download Folder". If Ask me 
where to save every file is selected, then Firefox will 
prompt you for a location to save every file you 
download. Selecting Save all files to this folder: will 
make it so every download goes to the same location. 
The Desktop is the default location for downloads on 

Windows.

Next, Show Download Manager when a download begins, which is enabled by default. 
This brings up the download manager for each file that is downloaded. You will 
manually have to close the Download Manager unless the preference Close the 
Download Manager when all downloads are complete is selected.

The final preference states Firefox can automatically download or open files of certain 
types. Pressing the View & Edit Actions... button will bring up a new window. It contains 
a list of file extensions, and default actions for files of that type. Each file type can be set 
to automatically open with its default application, automatically open with a non-default 
application, saved to the computer, or opened with a plugin (assuming the correct plugin 
is installed).

Advanced

This pane offers some advanced settings. There is a third tab offered under "Advanced", 
"Security". However, most users should not need to change any preferences on this tab.

General

The Advanced Tab with General selected

The setting Allow text to be selected with the keyboard 
controls caret browsing. When using caret browsing, a 

http://en.wikibooks.org/wiki/Using_Firefox:_Extensions


cursor is placed in the browser, and it can be moved with the arrow keys and used to 
select text. Pressing [F7] will also enable and disable this feature.

Begin finding when you begin typing is a setting for Find As You Type (FAYT). 
Normally, FAYT is activated only after pressing the / or ' keys, or by pressing [F3]. With 
this setting enabled, FAYT will begin when any key is pressed (as long as the cursor is 
not in a form, or other text entry area).

Resize large images to fit in the browser window will automatically resize any image that 
is larger than the current browser window so that it fits in the window without causing 
scrollbars. Clicking on the image will display it at its full size, and clicking on it again 
will resize it to fit the window.

Use autoscrolling toggles the ability to autoscroll. With autoscroll enabled, click the 
middle mouse button to enter autoscroll mode. While in autoscroll mode, simply move 
the mouse up to scroll up, and move the mouse down to scroll down. Clicking the middle 
mouse button again will exit autoscroll.

Use smooth scrolling toggles the ability to make scrolling with the mouse wheel 
"smoother" than normal.

Finally, click the Edit Languages... button to change the order of preference of languages 
for pages that offer more than one language.

Update

The Advanced Tab with Update selected

The Update tab changes the way Firefox checks for 
updates for itself, extensions and themes, and search 
engines. All three should remain checked, as critical 
security updates will use the Update system.

The final preference determines how to install updates. 
If Ask me what I want to do is selected, then Firefox will 

alert you when new updates are found and wait for instructions. If Automatically  
download and install the update is selected, Firefox will apply updates without asking. 
However, if Warn me if this will disable extensions or themes is checked, and a new 
update may break a currently installed extension or theme, Firefox will display a 
warning.

Finally, select the Show Update History button to see a list of previously installed 
updates, and what they contained.



Extensions
Extensions are small add-ons that add new functionality to Firefox. They can add 
anything from a toolbar button to a completely new feature. They allow the browser to be 
customized to fit the personal needs of each user if they need addtional features, while 
keeping Firefox small to download.

There are over 800 extensions available for Firefox. As you can see, it can be a bit 
difficult to find the most useful extensions for the average user. Here are just a few of the 
better ones. Mozilla Update, also called Mozilla Addons, is the official site from the 
Mozilla Foundation and each extension undergoes a miminum amount of testing before 
being listed. Extensions are categorized and can be rated on a scale from one to five. 
Extensions can also be listed by the Popularity (most downloads) and Rating. The site is 
Another popular page is Extensionsmirror which, although unofficial, maintains a good 
database of Firefox extensions. [3].

There are many themes available at Mozilla Update which make Firefox more attractive. 
A related extension is CuteMenus.

Blogging
• Deepest Sender   — A LiveJournal, Blogger, and WordPress client that supports 

only sending and editing entries. Its name is a very clever anagram.

Bookmarks
• LiveBookmarkThis   — Gives an Add Live Bookmark option to context menu 

when right-clicking links. Useful when you want to add RSS feeds to your 
bookmarks.

• OpenBook   — This extension allows for customization of the Add Bookmark 
dialog. The bookmarks tree can be automatically opened and elements can be 
hidden. The entire dialog can even be bypassed.

• Add Bookmark Here   — This extension adds an option to the bookmarks menu 
and/or the context menu for bookmark folders that enables you to add a bookmark 
to that folder.

Configuration
• Chromedit   — Edit configuration files, userChrome.css, userContent.css or user.js, 

without the hassle of finding your profile.

http://update.mozilla.org/extensions/moreinfo.php?id=17&page=releases
http://gorgias.de/mfe/index.php#abhere
http://update.mozilla.org/extensions/moreinfo.php?id=42&page=releases
http://en.wikibooks.org/wiki/RSS
http://update.mozilla.org/extensions/moreinfo.php?id=274&page=releases
http://en.wikipedia.org/wiki/WordPress
http://en.wikipedia.org/wiki/Blogger
http://en.wikipedia.org/wiki/LiveJournal
http://deepestsender.mozdev.org/
http://addons.mozilla.org/extensions/moreinfo.php?id=660
http://www.extensionsmirror.nl/


Developer Tools
• EditCSS  - Stylesheet modifier in the Sidebar. Allows you to edit any site's CSS 

file on the fly.

• Web Developer Extension  - Must have extension for anyone dabbling in web 
design.

Download Tools
• Download Statusbar   — View downloads in an auto-hide statusbar.

Miscellaneous
• BBCode   — Enables you to quickly and easily insert various BBCode tags in 

editable textboxes from the context menu. Very handy for customizing posts on 
forums.

• Calculator   — A simple calculator extension.

• Calculator   — An advanced calculator extension.

• Calendar   — An iCal compatible Calendar for Firefox. You can download 
calendars for your favourite sports teams, etc., from iCal Share

• ChatZilla   — A simple, straightforward Internet Relay Chat (IRC) client.

• FoxyTunes   — Adds media player controls within Firefox. Currently supports 
many different music players across multiple platforms.

• Gmail Notifier   — A Gmail notifier that integrates into the browser's user 
interface.

• FasterFox   — A simple-to-use performance and network tweaker. Fasterfox allows 
you to change certain setting to make Firefox load pages more quickly, depending 
on your computer speed and Internet connection.

• Quick Note   — A note taking extension with advanced features.

• StumbleUpon   — Lets you 'stumble upon' websites that have been recommended 
("thumbed up") by friends and community members with interests similar to your 
own. See also StumbleUpon website.

http://www.stumbleupon.com/
http://update.mozilla.org/extensions/moreinfo.php?id=138&page=releases
http://update.mozilla.org/extensions/moreinfo.php?id=46&page=releases
http://addons.mozilla.org/extensions/moreinfo.php?id=1269
http://update.mozilla.org/extensions/moreinfo.php?id=173&page=releases
http://update.mozilla.org/extensions/moreinfo.php?application=firefox&id=219
http://update.mozilla.org/extensions/moreinfo.php?id=16&page=releases
http://icalshare.com/
http://www.apple.com/ical/
http://www.mozilla.org/projects/calendar/
https://addons.mozilla.org/firefox/1194/
http://quicktools.mozdev.org/mozcalc/
http://update.mozilla.org/extensions/moreinfo.php?id=128&page=releases
http://update.mozilla.org/extensions/moreinfo.php?id=26&page=releases
http://update.mozilla.org/extensions/moreinfo.php?id=60&page=releases
http://update.mozilla.org/extensions/moreinfo.php?id=179&page=releases


• WebmailCompose   — Makes mailto: (email) links load a webmail mail compose 
window and adds a WebMailCompose link to the context menu. Now supports 
selected addresses.

• Wikipedia   — Provides text formatting options in the context menu for use on 
wiki sites based on Mediawiki, such as Wikipedia and Wikibooks.

Mouse gestures
• All-in-one mouse gestures   — Enables you to use the mouse for a wide variety of 

customizable shortcuts.

Navigation
• Linkification   — Injects CSS on the fly making text URLs clickable with the 

default option to supress referer information.

• Paste & Go   — Lets you paste a URL from the clipboard and directly load it.

News
• Sage   — A lightweight RSS and Atom feed aggregator. Very useful for viewing 

news from many sites.

Page Display
• Adblock Plus   — Blocks or hides advertisments and other annoyances from web 

pages, while still retaining the correct page format. It is designed to allow you to 
block flash and image banners built into the web page, as well as scripts. You add 
your own filters using wildcards (*) for simple filters, or RegEx (regular 
expresions) for advanced ones. An excellent maintained set of filters is here.

• Flashblock   — Allows you to easily block flash animations. Flash animations are 
replaced with an icon you click to play. May conflict with Adblock Plus and crash 
on some flash-intensive sites.

• Image Zoom   — Adds zoom functionality for images. Functionality is also 
included in the Mouse Gestures extension.

Search tools

http://update.mozilla.org/extensions/moreinfo.php?id=139&page=releases
http://flashblock.mozdev.org/
http://pierceive.com/
http://www.regular-expressions.info/
http://www.extensionsmirror.nl/index.php?showtopic=774
http://en.wikipedia.org/wiki/ATOM_feed
http://en.wikibooks.org/wiki/RSS
http://update.mozilla.org/extensions/moreinfo.php?id=77&page=releases
http://update.mozilla.org/extensions/moreinfo.php?id=65&page=releases
http://www.beggarchooser.com/firefox/
http://update.mozilla.org/extensions/moreinfo.php?id=12&page=releases
http://wikipedia.sourceforge.net/
http://wikipedia.mozdev.org/
http://update.mozilla.org/extensions/moreinfo.php?id=206&page=releases


• termBlaster   — Lets you search selected text using search engines selected by 
context menu. It comes with 110+ search engines from encyclopedias to 
translators to web-search engines organized in folders.

• Dictionary Search   — Looks up selected word in a (customizable) online 
dictionary. Functionality is also included in the SmartSearch extension, which 
lacks the 4 search limitation.

• Googlebar   — The Google Toolbar for Firefox. Additonally, Googlebar Lite 
provides a simpler interface (which is recommended for new users). [4]

• Groowe Search Toolbar   — Groowe Search Toolbar bundles Google toolbar, 
Yahoo, Ask Jeeves, Teoma, Amazon, Download.com and others. The application 
is available for Internet Explorer as well.

• Searchmaze Search Toolbar   — Search Google, Yahoo, Teoma, Amazon, 
Download.com and 150 other sites and search engines.

Tabs and windows
• Focus Last Selected Tab   — Brings focus to the last selected tab when closing the 

active tab. Functionality is also included in the TabMix extension.

• Session Saver   — Saves the open tabs when closing the browser, and restores them 
upon restarting it. Functionality is also included in the TabMix extension.

• Single Window   — A simple extension that allows Mozilla to fully utilize the 
built-in tabbed browsing behavior. Traps links that would normally open in a new 
window. Functionality is also included in the TabMix extension.

• Tabbrowser Preferences   — Enables enhanced control for tabbed browsing. Most 
functionality is also included in the TabMix extension. Recommended for users 
who would like to change the way tabs behave in Firefox.

• Tab Mix   — An extension with lots of features, including opening closed tabs, 
moving tab bar to the bottom, mouse gestures and much more. It is incompatible 
with various extensions that offer similar funcionality.

• Undoclosetab   — Reopen a closed tab. Functionality is also included in the 
TabMix, SessionSaver, and Mouse Gestures extensions.

http://update.mozilla.org/extensions/moreinfo.php?id=58&page=releases
http://tabmix-en.blogspot.com/
http://update.mozilla.org/extensions/moreinfo.php?id=158&page=releases
http://update.mozilla.org/extensions/moreinfo.php?id=50&page=releases
http://extensionroom.mozdev.org/more-info/sessionsaver
http://update.mozilla.org/extensions/moreinfo.php?id=32&page=releases
http://www.searchmaze.com/
http://www.groowe.com/
https://addons.mozilla.org/extensions/moreinfo.php?id=492
http://update.mozilla.org/extensions/moreinfo.php?application=firefox&id=33&page=releases
http://update.mozilla.org/extensions/moreinfo.php?id=68&page=releases
http://addons.mozilla.org/extensions/moreinfo.php?id=1720


Plug-ins
What is a Plugin?
Firefox requires plugins in order to read or display special content from the websites. 
Plugins are programs that are integrated into Firefox that allows websites to provide 
content to you. Such content includes flash videos, java games and streaming video from 
the Internet. Examples of plugins are Flash, RealPlayer, and Java. Plugins are a necessary 
component to truly access the Internet's interactive stuff.

A much more comprehensive list of plugins, with detailed installation instructions, is 
available at Mozilla Update. Another valuable resource is Mozdev Plugins.

Before You Install

Close Firefox before installing plugins

Firefox should be closed before running any plugin installation programs, as existing files 
may be overwritten during the installation process.

Using XPInstall to install plugins

Some plugins are available as XPInstall packages (XPIs), the same format as that for 
extensions. Where XPIs are available, it is recommended you use them as they often 
install the plugin automatically without you having to restart Firefox. After the XPI has 
finished installing, you should restart your browser.

Checking which plugins you have installed

To check what plugins you have installed, simply type about:plugins in the Location bar. 
This page will show which plugins are installed, what file types they are associated with 
and if the plugin is enabled or disabled.

Available Plugins

Adobe PDF Reader

In order to read .pdf files, you need to install a pdf reader. Adobe Reader, one of the more 
popular software, can do this. Simply go to Adobe's official site and download Adobe 
Reader. With Firefox closed, install Adobe Reader and it will also install the plugin 
necessary for Firefox to view PDF files. No other steps are necessary. Firefox will now 
open all PDFs from within a Firefox tab.

http://www.adobe.com/products/acrobat/readstep2.html
http://plugindoc.mozdev.org/
http://pfs.mozilla.org/plugins/
http://en.wikibooks.org/wiki/Using_Firefox/Print#Java
http://en.wikibooks.org/wiki/Using_Firefox/Print#RealPlayer
http://en.wikibooks.org/wiki/Using_Firefox/Print#Macromedia_Flash_Player


If you install Adobe Reader after Firefox, Adobe Reader will automatically select the 
right plugin. If you already have the latest version of Adobe Reader installed then Firefox 
will automatically use the plugin. Some people have problems with the Adobe Reader 
plugin in Firefox. The explanation and solution is here.

Java

The Java Plugin is part of the Java Runtime Environment. The Java Runtime 
Environment installer will install the Java Plugin for Netscape 7.2 and Mozilla 
automatically. Simpy install Java Runtime Environment 5.0 or download Java Runtime 
Environment 5.0 Offline Installer.

Macromedia Flash Player

When you encounter a site that makes use of Flash graphics, a yellow bar will appear at 
the top of the page telling you that there is a missing plugin preventing you from viewing 
all the content on the current page. Click on Install Missing Plugins button and the 
Mozilla Plugin Finder Service will appear automatically. After accepting the User 
Agreement from Macromedia, the necessary components to view Flash will be installed.

Alternately, you may install Macromedia Flash Player (without having to go to a site) by 
installing the plugin manually. Simply go here and click on the Macromedia Flash Player 
8.0 link.

Macromedia Shockwave Player

Simply go to the Macromedia Shockwave site and download the plugin. When you are 
installing it, Firefox will appear in the list of browsers that you can install the plugin for. 
(Remember, Firefox should be closed when installing).

Quicktime Player (Windows & Mac)

Simply go to Apple's (the developer of Quicktime) website and download Quicktime. 
Installing Quicktime will install the appropriate plugin in order for Firefox to view .mov 
files.

RealPlayer

Simply go to Real's (the developer of RealPlayer) website and download the program. 
The RealPlayer installer will automatically detect your browser's plugins folder and 
install the plugin. Bold text  link title  

Uninstalling Plugins

http://www.example.com/
http://en.wikibooks.org/w/index.php?title=Bold_text&action=edit
http://www.real.com/freeplayer/?rppr=rnwk
http://www.apple.com/quicktime/download/
http://sdc.shockwave.com/shockwave/download/download.cgi?
http://plugindoc.mozdev.org/windows.html#Flash
http://javashoplm.sun.com/ECom/docs/Welcome.jsp?StoreId=22&PartDetailId=jre-1.5.0-oth-JPR&SiteId=JSC&TransactionId=noreg
http://javashoplm.sun.com/ECom/docs/Welcome.jsp?StoreId=22&PartDetailId=jre-1.5.0-oth-JPR&SiteId=JSC&TransactionId=noreg
http://java.sun.com/update/1.5.0/jre-1_5_0-windows-i586.xpi
http://kb.mozillazine.org/index.phtml?title=Adobe_Reader


A list of your installed plugins can be obtained from about:plugins. As a general rule, to 
remove a plugin, you remove the file listed in about:plugins for it.

Mouse shortcuts
Note: for Mac OS X, use the Command key in place of Control for all shortcuts  
listed.

Standard Firefox Mouse Shortcuts
Back Shift+Scroll down
Close Tab Middle-click on Tab Bar
Decrease Text Size Ctrl+Scroll up
Force Reload (override cache) Shift+Reload button
Forward Shift+Scroll up
Increase Text Size Ctrl+Scroll down
New Tab Double-Click on Tab Bar
Open Link in Background Tab Ctrl+Left-click or Middle-click on a link
Open Link in Foreground Tab Ctrl+Shift+Left-click or Shift+Middle-click on a link
Open Link in New Window Shift+Left-click on a link
Save Link As Alt+Left-click on a link
Scroll line by line Alt+Scroll

Keyboard shortcuts
Standard Firefox Keyboard Shortcuts

Note: for Mac OS X, use the Command key in place of Control for all shortcuts  
listed.

Back Alt+Left Arrow (or Backspace on Windows)
Bookmarks Ctrl+B or Ctrl+I
Bookmark This Page Ctrl+D
Bookmark All Tabs Ctrl+Shift+D
Caret Browsing F7
Clear Personal Data Ctrl+Shift+Del
Close Tab Ctrl+W or Ctrl+F4
Close Window Ctrl+Shift+W or Alt+F4
Complete .com Address Ctrl+Enter
Complete .net Address Shift+Enter



Complete .org Address Ctrl+Shift+Enter
Copy Ctrl+C or Ctrl+Insert
Cut Ctrl+X or Shift+Del
Delete Del

Downloads Ctrl+J (Windows & Mac OS X only), Ctrl+Y 
(Linux only)

Find Again F3 or Ctrl+G
Find in This Page (Find As You 
Type) Ctrl+F or /

Find in This Page (Find As You 
Type): links only ' (apostrophe key)

Find Previous Shift+F3 or Shift+Ctrl+G
Force Reload (override cache) Ctrl+F5 or Ctrl+Shift+R

Forward Alt+Right Arrow (or Shift+Backspace on 
Windows)

Full Screen F11
History Ctrl+H
Home Alt+Home
Location Bar F6 or Ctrl+L or Alt+D
New Tab Ctrl+T
Next Frame F6

Next Tab Ctrl+Tab or Ctrl+PageDown or Ctrl+Alt+Right 
Arrow

New Window Ctrl+N
Open File Ctrl+O
Open Location in New Tab Alt+Enter
Page Source Ctrl+U
Paste Ctrl+V or Shift+Insert
Previous Frame Shift+F6

Previous Tab Ctrl+Shift+Tab or Ctrl+PageUp or Ctrl+Alt+Left 
Arrow

Print Ctrl+P
Redo Ctrl+Y (NOT Linux) or Ctrl+Shift+Z
Reload F5 or Ctrl+R
Save Page As Ctrl+S
Search see Find and Web Search
Select All Ctrl+A
Select Next Search Engine in Search 
Bar Ctrl+Down

Select Previous Search Engine in 
Search Bar Ctrl+Up

Select Tab [1 to 9] Ctrl+[1 to 9]
Stop Esc



Text Size: Decrease Ctrl+-
Text Size: Increase Ctrl++
Text Size: Normal Ctrl+0

Web Search Ctrl+K (or Ctrl+E on Windows & Mac OS X, or 
Ctrl+J on Unix)

Undo Ctrl+Z

Privacy
Clearing Private Data

History

It is possible to select individual history items to delete, by 
using the history side bar. You can open the history side bar 
by selecting from the menu the View -> Sidebar -> History 
option. Deleting singular items can be achieved by finding 
the item, right-clicking on it to get the context menu, and 
selecting Delete. Deleting multiple entried can be achieved 
by right-clicking the list to focus it (for left-clicking will 

open the web page under the mouse, and losing focus on the list) and using the up/down 
arrows, and shift+up/down to select blocks of entries. Pressing Delete on the keyboard 
will delete the selected history items.

It is possible to delete all history items by opening the preferences dialog on the menu at 
Edit -> Preferences, and clicking on the Privacy tab and then the History tab. A button 
will be there to Clear Browsing History Now. This will clear all history items.

Under this tab also, by changing the option Remember my browsing history for X days, to 
0, history items will not be kept between sessions.

Auto-completed URLs will disappear as corresponding history items are deleted.

Cookies

Cookies can be cleared by selecting the Privacy tab and 
then the Cookies tab under the user preferences from the 



menu at Edit -> Preferences. All cookied can be deleted by clicking the Clear Cookies 
Now button. Individual cookies can be cleared by clicking the View Cookies button to 
open the cookie viewing dialog. Selecting cookies and pressing Delete on the keyboard 
will delete those cookies.

By changing the option to Keep Cookies to Until I close Firefox, cookies will not be kept 
between sessions. Also it is possible to choose to block all websites from putting cookies 
on your computer unless you have explicitly allowed them to do so, by adding them to a 
list accessible from this tab.

Other Data

It is possible to delete other private data by using options under the Privacy tab of the 
user preferences. See Preferences for more details.

Deleting All Private Data

You can delete all private data, including browsing history, cookies, cache, saved form 
data, passwords, and download history, by opening the Clear Private Data dialog under 
the menu in Tools -> Clear Private Data (or by pressing Ctrl-Shift-Delete on your 
keyboard). This will ask you to list your preferences as to what should be cleared from 
Firefox. If you want to do the same thing often in the future, you can deselect Ask me 
before clearing private data, and the dialog will not be cleared.

Your preferences for this option can be set in the user preferences dialog under the 
Privacy tab; there is a button down the bottom right that says Settings, which will effect 
this function.

Advanced configuration
about:config
Type about:config into your address bar and you will be brought to the about:config 
settings. This is a powerful way to tweak your settings in ways that are not normally 
accessible through the Options menu. By simply double clicking one of the available 
options (after copying and pasting them into the filter bar to find them easily), changes 
can be made, including the following:

• browser.block.target_new_window — if set to true, links that normally force a 
new window to open will open in the current window instead.

• browser.xul.error_pages.enabled — if set to true, Firefox displays an error page 
similar to IE instead of a message box if loading a page fails.

http://en.wikibooks.org/wiki/Using_Firefox/Preferences#Privacy


• layout.frames.force_resizability — if set to true, allows the user to resize frames 
on any web site that uses them.

The following changes can be made to speed up browsing. Normally the browser will 
make one request to a web page at a time. When you enable pipelining it will make 
several at once, which usually speeds up page loading. Make these changes to enable 
pipelining:

Set "network.http.pipelining" to "true"

Set "network.http.proxy.pipelining" to "true"

[Tip: If have your browser set to connect to an optional http proxy, you can leave 
"network.http.pipelining" setp to "false", then add the domains of websites that don't 
work with pipelining (like images.google.com) to the proxy exclude list.]

Set "network.http.pipelining.maxrequests" to 8. This means it will make up to 8 requests 
at once rather than the default of 4. This is only an advantage if you have a reliable 
internet connection that isn't particularly slow.

Finally, right-click anywhere and select New-> Integer. Name it 
"nglayout.initialpaint.delay" and set its value to "0". This value is the amount of time the 
browser waits before it acts on information it receives, but it will increase the total time 
taken to render the page. This option is more suitable for a faster computer ("250" is the 
default). Try a value of "100" if "0" causes problems.

For broadband users:

Set "network.http.max-connections-per-server" to 14. Many guides recommend setting 
this figure to 100, but this can have undesriable effects upon webservers.

Set "network.http.max-connections" to 48

A much more complete list can be found here, with descriptions and which values the 
preference will take (where applicable)

Editing the userChrome.css File
userChrome.css is a file that allows you to change the appearance of Firefox with CSS 
rules. The actual browser window (i.e., not the webpage, but everything else) is called the 
"chrome". The file userChrome.css overrides default settings to allow for more 
customization.

userChrome.css is not created by default. It should be created in your profile folder, 
which can be found in the following places:

http://preferential.mozdev.org/preferences.html


Windows 98/ME:
 C:\Windows\Application Data\Mozilla\Firefox\Profiles\<Profile name>\
or
 C:\Windows\Profiles\<Windows user name>\Application 
Data\Mozilla\Firefox\Profiles\<Profile name>\
Windows 2000/XP:
 C:\Documents and Settings\<Windows login/user name>\Application 
Data\Mozilla\Firefox\Profiles\<Profile name>\
Linux:
 ~/.mozilla/firefox/<Profile name>/
Mac OS X:
 ~/Library/Mozilla/Firefox/Profiles/<Profile name>/
or
 ~/Library/Application Support/Firefox/Profiles/<Profile name>/

In all cases, the profile is randomly named, with 8 characters followed by .default. Inside 
that folder is another named "chrome". Inside the chrome folder is where userChrome.css 
needs to be created. There should be a file named "userChrome-example.css" that can 
simply be renamed to work.

Editing the userContent.css File

Tips
• Allowing extension downloads from mozilla.org instead of www.mozilla.org will 

match all subdomains of mozilla.org, just as blocking cookies from 
doubleclick.net instead of www.doubleclick.net will allow blocking of all 
doubleclick.net subdomains. Allowing "www.mozilla.org" would not allow 
"addons.mozilla.org". However, as a security measure, when whitelisting sites for 
extensions, the most specific domain available should be used (i.e., 
addons.mozilla.org instead of mozilla.org) to prevent potentially malicious 
installs from other subdomains on a site.

Developers tools
Extension Development
The most comprehensive site for Extension development is at the Mozillazine 
Knowledge Base found here. Other helpful tools include the DOM Inspector included in 
Firefox and the JavaScript console.

http://www.mozilla.org/projects/inspector/
http://kb.mozillazine.org/Extension_development


Firefox is especially developer-friendly. It allows even the most casual web developer to 
crib useful HTML techniques from most any website they visit, and offers a host of other 
features for more serious users.

Source viewing
Perhaps the most-used development feature is the ability to highlight images and text in 
any website, and choose to view source from a drop-down menu. When this feature is 
used, Firefox displays the HTML source that was used to generate the highlighted 
content.

For instance, highlighting the above paragraph and section heading, right clicking, and 
choosing "View Selection Source", will display the following in a new window:

<p><a name="Source_viewing" id="Source_viewing"></a></p>
<h2>Source viewing</h2>
<p>Perhaps the most-used development feature is the ability to 
highlight images and text in any website, and choose "<i>View selection 
source</i>" from the drop-down menu. Doing this will bring up a pop-up 
window, with the HTML source that was used to generate the highlighted 
content.</p>

Combining this technique with a good markup language reference source, such as the 
Wikibook Programming:HTML, will allow you to learn from every new website you 
visit.

Further Reading
Helpful Links

• Why switch to Firefox?   — Reasons to switch.
• Portable Firefox   — John Haller has repackaged firefox to be run from a 

removable storage device (such as a USB key or a zip disk).

Getting Started
• Firefox Help   — Online Help for the Mozilla Firefox Web Browser
• Getting started with Mozilla Firefox  
• A Beginner's Guide to Firefox   by Anders Conbere
• Firefox Guide   by Evolusion.net
• MozillaZine Knowledge Base wiki  
• Mozilla Community wiki  

http://mozilla.wikicities.com/
http://kb.mozillazine.org/
http://evolusion.net/
http://evolusion.net/index.php?page_id=75
http://www.bytecave.net/anders/guide/
http://www.edafe.org/firefox/
http://www.mozilla.org/support/firefox/
http://johnhaller.com/jh/mozilla/portable_firefox/
http://www.switch2firefox.com/whyswitch/
http://en.wikibooks.org/wiki/Programming:HTML
http://en.wikibooks.org/wiki/Main_Page


• MozillaZine Forums  - If you have any problems with Firefox this should be your 
first port of call.

• Firefox Resources  

Plugins, Extensions, and Tweaks
• PluginDoc   — Lists common plugins and how to install them in Firefox.
• Mozilla Addons   — Official Mozilla site for plugins, extensions and themes.
• Extensionmirror.nl   — unofficial extension database
• Firefox Tweak Guide   — Has some great tweaks for speed and various other 

customizations.
• How to write Firefox extensions   — Tutorial for creating Firefox extensions, 

which includes a "Hello, world!" extension to explain the basics.

License
GNU Free Documentation License
Version 1.2, November 2002

Copyright (C) 2000,2001,2002  Free Software Foundation, Inc.

http://extensions.roachfiend.com/howto.html
http://www.tweakfactor.com/articles/tweaks/firefoxtweak/
http://www.extensionsmirror.nl/
https://addons.mozilla.org/
http://plugindoc.mozdev.org/
http://loadaveragezero.com/app/drx/Internet/WWW/Clients/Browsers/Firefox
http://forums.mozillazine.org/


51 Franklin St, Fifth Floor, Boston, MA  02110-1301  USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other functional and useful 
document "free" in the sense of freedom: to assure everyone the effective freedom to 
copy and redistribute it, with or without modifying it, either commercially or 
noncommercially. Secondarily, this License preserves for the author and publisher a way 
to get credit for their work, while not being considered responsible for modifications 
made by others.

This License is a kind of "copyleft", which means that derivative works of the document 
must themselves be free in the same sense. It complements the GNU General Public 
License, which is a copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because 
free software needs free documentation: a free program should come with manuals 
providing the same freedoms that the software does. But this License is not limited to 
software manuals; it can be used for any textual work, regardless of subject matter or 
whether it is published as a printed book. We recommend this License principally for 
works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work, in any medium, that contains a notice 
placed by the copyright holder saying it can be distributed under the terms of this 
License. Such a notice grants a world-wide, royalty-free license, unlimited in duration, to 
use that work under the conditions stated herein. The "Document", below, refers to any 
such manual or work. Any member of the public is a licensee, and is addressed as "you". 
You accept the license if you copy, modify or distribute the work in a way requiring 
permission under copyright law.

A "Modified Version" of the Document means any work containing the Document or a 
portion of it, either copied verbatim, or with modifications and/or translated into another 
language.

A "Secondary Section" is a named appendix or a front-matter section of the Document 
that deals exclusively with the relationship of the publishers or authors of the Document 
to the Document's overall subject (or to related matters) and contains nothing that could 
fall directly within that overall subject. (Thus, if the Document is in part a textbook of 
mathematics, a Secondary Section may not explain any mathematics.) The relationship 
could be a matter of historical connection with the subject or with related matters, or of 
legal, commercial, philosophical, ethical or political position regarding them.



The "Invariant Sections" are certain Secondary Sections whose titles are designated, as 
being those of Invariant Sections, in the notice that says that the Document is released 
under this License. If a section does not fit the above definition of Secondary then it is 
not allowed to be designated as Invariant. The Document may contain zero Invariant 
Sections. If the Document does not identify any Invariant Sections then there are none.

The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts 
or Back-Cover Texts, in the notice that says that the Document is released under this 
License. A Front-Cover Text may be at most 5 words, and a Back-Cover Text may be at 
most 25 words.

A "Transparent" copy of the Document means a machine-readable copy, represented in a 
format whose specification is available to the general public, that is suitable for revising 
the document straightforwardly with generic text editors or (for images composed of 
pixels) generic paint programs or (for drawings) some widely available drawing editor, 
and that is suitable for input to text formatters or for automatic translation to a variety of 
formats suitable for input to text formatters. A copy made in an otherwise Transparent 
file format whose markup, or absence of markup, has been arranged to thwart or 
discourage subsequent modification by readers is not Transparent. An image format is 
not Transparent if used for any substantial amount of text. A copy that is not 
"Transparent" is called "Opaque".

Examples of suitable formats for Transparent copies include plain ASCII without 
markup, Texinfo input format, LaTeX input format, SGML or XML using a publicly 
available DTD, and standard-conforming simple HTML, PostScript or PDF designed for 
human modification. Examples of transparent image formats include PNG, XCF and 
JPG. Opaque formats include proprietary formats that can be read and edited only by 
proprietary word processors, SGML or XML for which the DTD and/or processing tools 
are not generally available, and the machine-generated HTML, PostScript or PDF 
produced by some word processors for output purposes only.

The "Title Page" means, for a printed book, the title page itself, plus such following 
pages as are needed to hold, legibly, the material this License requires to appear in the 
title page. For works in formats which do not have any title page as such, "Title Page" 
means the text near the most prominent appearance of the work's title, preceding the 
beginning of the body of the text.

A section "Entitled XYZ" means a named subunit of the Document whose title either is 
precisely XYZ or contains XYZ in parentheses following text that translates XYZ in 
another language. (Here XYZ stands for a specific section name mentioned below, such 
as "Acknowledgements", "Dedications", "Endorsements", or "History".) To "Preserve the 
Title" of such a section when you modify the Document means that it remains a section 
"Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this 
License applies to the Document. These Warranty Disclaimers are considered to be 



included by reference in this License, but only as regards disclaiming warranties: any 
other implication that these Warranty Disclaimers may have is void and has no effect on 
the meaning of this License.

2. VERBATIM COPYING
You may copy and distribute the Document in any medium, either commercially or 
noncommercially, provided that this License, the copyright notices, and the license notice 
saying this License applies to the Document are reproduced in all copies, and that you 
add no other conditions whatsoever to those of this License. You may not use technical 
measures to obstruct or control the reading or further copying of the copies you make or 
distribute. However, you may accept compensation in exchange for copies. If you 
distribute a large enough number of copies you must also follow the conditions in section 
3.

You may also lend copies, under the same conditions stated above, and you may publicly 
display copies.

3. COPYING IN QUANTITY
If you publish printed copies (or copies in media that commonly have printed covers) of 
the Document, numbering more than 100, and the Document's license notice requires 
Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all 
these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the 
back cover. Both covers must also clearly and legibly identify you as the publisher of 
these copies. The front cover must present the full title with all words of the title equally 
prominent and visible. You may add other material on the covers in addition. Copying 
with changes limited to the covers, as long as they preserve the title of the Document and 
satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the 
first ones listed (as many as fit reasonably) on the actual cover, and continue the rest onto 
adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, 
you must either include a machine-readable Transparent copy along with each Opaque 
copy, or state in or with each Opaque copy a computer-network location from which the 
general network-using public has access to download using public-standard network 
protocols a complete Transparent copy of the Document, free of added material. If you 
use the latter option, you must take reasonably prudent steps, when you begin distribution 
of Opaque copies in quantity, to ensure that this Transparent copy will remain thus 
accessible at the stated location until at least one year after the last time you distribute an 
Opaque copy (directly or through your agents or retailers) of that edition to the public.



It is requested, but not required, that you contact the authors of the Document well before 
redistributing any large number of copies, to give them a chance to provide you with an 
updated version of the Document.

4. MODIFICATIONS
You may copy and distribute a Modified Version of the Document under the conditions 
of sections 2 and 3 above, provided that you release the Modified Version under precisely 
this License, with the Modified Version filling the role of the Document, thus licensing 
distribution and modification of the Modified Version to whoever possesses a copy of it. 
In addition, you must do these things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the 
Document, and from those of previous versions (which should, if there were any, 
be listed in the History section of the Document). You may use the same title as a 
previous version if the original publisher of that version gives permission.
B. List on the Title Page, as authors, one or more persons or entities responsible 
for authorship of the modifications in the Modified Version, together with at least 
five of the principal authors of the Document (all of its principal authors, if it has 
fewer than five), unless they release you from this requirement.
C. State on the Title page the name of the publisher of the Modified Version, as 
the publisher.
D. Preserve all the copyright notices of the Document.
E. Add an appropriate copyright notice for your modifications adjacent to the 
other copyright notices.
F. Include, immediately after the copyright notices, a license notice giving the 
public permission to use the Modified Version under the terms of this License, in 
the form shown in the Addendum below.
G. Preserve in that license notice the full lists of Invariant Sections and required 
Cover Texts given in the Document's license notice.
H. Include an unaltered copy of this License.
I. Preserve the section Entitled "History", Preserve its Title, and add to it an item 
stating at least the title, year, new authors, and publisher of the Modified Version 
as given on the Title Page. If there is no section Entitled "History" in the 
Document, create one stating the title, year, authors, and publisher of the 
Document as given on its Title Page, then add an item describing the Modified 
Version as stated in the previous sentence.
J. Preserve the network location, if any, given in the Document for public access 
to a Transparent copy of the Document, and likewise the network locations given 
in the Document for previous versions it was based on. These may be placed in 
the "History" section. You may omit a network location for a work that was 
published at least four years before the Document itself, or if the original 
publisher of the version it refers to gives permission.
K. For any section Entitled "Acknowledgements" or "Dedications", Preserve the 
Title of the section, and preserve in the section all the substance and tone of each 
of the contributor acknowledgements and/or dedications given therein.



L. Preserve all the Invariant Sections of the Document, unaltered in their text and 
in their titles. Section numbers or the equivalent are not considered part of the 
section titles.
M. Delete any section Entitled "Endorsements". Such a section may not be 
included in the Modified Version.
N. Do not retitle any existing section to be Entitled "Endorsements" or to conflict 
in title with any Invariant Section.
O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as 
Secondary Sections and contain no material copied from the Document, you may at your 
option designate some or all of these sections as invariant. To do this, add their titles to 
the list of Invariant Sections in the Modified Version's license notice. These titles must be 
distinct from any other section titles.

You may add a section Entitled "Endorsements", provided it contains nothing but 
endorsements of your Modified Version by various parties--for example, statements of 
peer review or that the text has been approved by an organization as the authoritative 
definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 
25 words as a Back-Cover Text, to the end of the list of Cover Texts in the Modified 
Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be 
added by (or through arrangements made by) any one entity. If the Document already 
includes a cover text for the same cover, previously added by you or by arrangement 
made by the same entity you are acting on behalf of, you may not add another; but you 
may replace the old one, on explicit permission from the previous publisher that added 
the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to 
use their names for publicity for or to assert or imply endorsement of any Modified 
Version.

5. COMBINING DOCUMENTS
You may combine the Document with other documents released under this License, 
under the terms defined in section 4 above for modified versions, provided that you 
include in the combination all of the Invariant Sections of all of the original documents, 
unmodified, and list them all as Invariant Sections of your combined work in its license 
notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical 
Invariant Sections may be replaced with a single copy. If there are multiple Invariant 
Sections with the same name but different contents, make the title of each such section 
unique by adding at the end of it, in parentheses, the name of the original author or 
publisher of that section if known, or else a unique number. Make the same adjustment to 



the section titles in the list of Invariant Sections in the license notice of the combined 
work.

In the combination, you must combine any sections Entitled "History" in the various 
original documents, forming one section Entitled "History"; likewise combine any 
sections Entitled "Acknowledgements", and any sections Entitled "Dedications". You 
must delete all sections Entitled "Endorsements."

6. COLLECTIONS OF DOCUMENTS
You may make a collection consisting of the Document and other documents released 
under this License, and replace the individual copies of this License in the various 
documents with a single copy that is included in the collection, provided that you follow 
the rules of this License for verbatim copying of each of the documents in all other 
respects.

You may extract a single document from such a collection, and distribute it individually 
under this License, provided you insert a copy of this License into the extracted 
document, and follow this License in all other respects regarding verbatim copying of 
that document.

7. AGGREGATION WITH INDEPENDENT WORKS
A compilation of the Document or its derivatives with other separate and independent 
documents or works, in or on a volume of a storage or distribution medium, is called an 
"aggregate" if the copyright resulting from the compilation is not used to limit the legal 
rights of the compilation's users beyond what the individual works permit. When the 
Document is included in an aggregate, this License does not apply to the other works in 
the aggregate which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, 
then if the Document is less than one half of the entire aggregate, the Document's Cover 
Texts may be placed on covers that bracket the Document within the aggregate, or the 
electronic equivalent of covers if the Document is in electronic form. Otherwise they 
must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the 
Document under the terms of section 4. Replacing Invariant Sections with translations 
requires special permission from their copyright holders, but you may include translations 
of some or all Invariant Sections in addition to the original versions of these Invariant 
Sections. You may include a translation of this License, and all the license notices in the 
Document, and any Warranty Disclaimers, provided that you also include the original 
English version of this License and the original versions of those notices and disclaimers. 



In case of a disagreement between the translation and the original version of this License 
or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled "Acknowledgements", "Dedications", or 
"History", the requirement (section 4) to Preserve its Title (section 1) will typically 
require changing the actual title.

9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document except as expressly 
provided for under this License. Any other attempt to copy, modify, sublicense or 
distribute the Document is void, and will automatically terminate your rights under this 
License. However, parties who have received copies, or rights, from you under this 
License will not have their licenses terminated so long as such parties remain in full 
compliance.

[edit]

10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation may publish new, revised versions of the GNU Free 
Documentation License from time to time. Such new versions will be similar in spirit to 
the present version, but may differ in detail to address new problems or concerns. See 
http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document 
specifies that a particular numbered version of this License "or any later version" applies 
to it, you have the option of following the terms and conditions either of that specified 
version or of any later version that has been published (not as a draft) by the Free 
Software Foundation. If the Document does not specify a version number of this License, 
you may choose any version ever published (not as a draft) by the Free Software 
Foundation.

External links
• GNU Free Documentation License   (Wikipedia article on the license)
• Official GNU FDL webpage  

http://www.gnu.org/copyleft/fdl.html
http://en.wikipedia.org/wiki/GNU_Free_Documentation_License
http://www.gnu.org/copyleft/
http://en.wikibooks.org/w/index.php?title=GNU_Free_Documentation_License&action=edit&section=11
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